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SemTalk minimum requirements: 

 Microsoft Visio® 2003 or Microsoft Visio® 2007, Microsoft Visio® 2010 

 Microsoft .NET Framework Version 3.5 Redistributable Package  

o Download Link: (http://www.microsoft.com/downloads/) 

 

 

NOTE SemTalk‟s startup language will be set according to your system settings. To change your 

regional settings and system language please go to Window‟s START  Settings   System control 

 Regional and language settings. 

You may also change the start language in SemTalk without modifying your computer‟s regional 

settings. In SemTalk go to menu bar option Tools  SemTalk Options Language (Tab)  GUI 

Language and choose a language or the source of start language setting.

http://www.microsoft.com/downloads/
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What is SemTalk? 
SemTalk is a user-friendly editor for Semantic Web ontologies and processes. Because Microsoft 

Visio® is embedded in SemTalk, it combines the graphical strength of Microsoft Visio® and the 

consistency of a professional modeling tool.  

New modeling methodologies for virtually any modeling problem are easily defined using SemTalk. 

Applying a graphically configurable metamodel, Microsoft Visio®
 
can be adapted to different 

modeling worlds such as CASE Tools, organizational models and object models. 

The main purpose of this tutorial is to learn how to use SemTalk.  This tutorial does not include 

specific methodologies nor SemTalk Web or BPM use cases. It is assumed that the reader is familiar 

with the basic Microsoft Visio® functionalities.  

The of process modeling using specific business process modeling methods (e.g. CSA, EPC, BPMN, 

Promet and others) is covered in additional tutorials. You can find these tutorials at our homepage 

www.semtalk.com/manuals. 

What is an Ontology? 

For the purposes of this tutorial an ontology is a formal explicit description of concepts (i.e. classes) in 

a domain of discourse, properties of each concept describing various features and attributes, and 

restrictions on properties and attributes (i.e. relation and data types). In simple words, an ontology is a 

formal model for a specific domain of knowledge. An ontology together with a set of individual 

instances of classes constitutes a knowledge base. 

Ontologies are developed to provide a machine-understandable semantics of information sources that 

can be communicated between different agents (software and humans). Some reasons to develop 

ontologies are: 

 to share common understanding of the structure of information among people or software 

agents. 

 to enable reuse of domain knowledge. 

 to make domain assumptions explicit. 

 to separate domain knowledge from the operational knowledge. 

 to analyze domain knowledge. 

Web Ontology Language (OWL) is a W3C recommendation for the representation of ontologies. 

In case you want to work with OWL, you should use the OWL Template: File->New and select 

OWL.vst in the SemTalk program directory. In this tutorial, we will use the SemTalk default 

notation, which is a subset of OWL. OWL Export / Import is explained at 24.4 

Getting Started 
After installing SemTalk you can start working with SemTalk by clicking on it‟s icon on the desktop 

or selecting Start  Programs  SemTalk  SemTalk2. 

If you are starting SemTalk for the very first time after installing it you will see the following dialog 

box: 

http://www.semtalk.com/manuals
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For this tutorial, you will use SemTalk‟s most basic modeling notation. Please select the last node on 

the tree structure „No metamodel (semtalk.vst)‟. 

After doing this, the following screen will appear: 
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In this tutorial, we will develop a simple ontology about the users and products.  
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SemTalk as Visio Add-On 

You may also start SemTalk embedded into Visio. In order to do that you must have installed the 

SemTalk Visio Add-On. The SemTalk Visio COM Add-On is a separate and independent application 

and it is not installed when you install SemTalk. You can find the installation file Setup.exe in the 

program directory where SemTalk was installed (usually under C:\Program_Files\Semtation 

GmbH\SemTalk3\setup.exe) 

Start Visio 2007 or Visio 2003 and open a SemTalk Template (semtalk.VST or OWL.vst): 

 

You will find SemTalk now embedded into the Visio Menu. Using SemTalk from Visio 2007/2003 is 

recommended, if you need the collaboration functions of Microsoft Office 2007/2003, especially 

Sharepoint Team Services integration. Please be aware that some functionality such as “Searching”, 

“Save as Html” is available from Visio and from SemTalk. The SemTalk variant is obviously 

preferred. In this tutorial, we will use the SemTalk program version. 
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Instance Diagram 
With the instance editor, you will create diagrams for concrete objects having a specific identity. 

Instance diagrams are used in SemTalk solutions for business processes, org. charts, data warehouse 

cubes, product models etc. Virtually any Visio drawing containing real world objects such as buildings 

or a subway map would be an instance diagram.  

Diagrams, which are not instance diagrams, are called class diagrams. Class Diagrams contain abstract 

objects like data types and classes. In the Visio world, classes correspond to masters and instances to 

the shapes in the drawing. Class diagrams are explained in chapter 4. 

 

As you may have noticed, SemTalk starts with an instance diagram “First Page”. To create new 

instance diagram you may select from the menu bar Diagram  New  Instance Diagram or select 

from SemTalk‟s Explorer (tree structure) the node Diagrams/Generic and from its context menu 

(right click on the Generic node) the option Instance Diagram.  

Creating an Instance 

To create an instance just drag and drop an “Instance” symbol from a stencil in the drawing area. 

Please open a Visio® stencil e.g., File  Open Stencil select C:\Program Files\Microsoft 

Office\Office12\1033\WRKFLO_M.VSS (for English Visio 2007). In the embedded Version, use File 

 Shapes to open a stencil. Now, please find and open the stencil “Work Flow Diagram Shapes” 

(file: WRKFLO_M.VSS). See section 0 to learn how to work with Visio stencils. 

 

Now, you can drag & drop your shape of preference in the drawing area. In this case, please use the 

shape titled “User”. Repeat this procedure once more. You can use the shape search function on top of 

the stencil window. In this way, you can look for special shapes in the installed Visio® stencils. Please 

find a “User” shape now. Once you find it, drag & drop the shape in the drawing area twice. 
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SemTalk assigns automatically an individual name to each object according to the name they have in 

the Visio® stencil. For example, “User.14” and “User.15 are different objects of the class “User”. If 

you select them you can simply type in the new name. 

 

 To change the object‟s name or other property make double-click on the shape or click the right 

button of your mouse and select Edit.  
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Consistency 

 

When duplicating an object with SemTalk, it is necessary to maintain its consistency. For example, if 

the user modifies the name of an object, the modification must also occur in every duplicate of that 

object. 

Please create a second shape for the Instance “John” by using Copy&Paste. (Ctrl-C, Ctrl-V) 
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Now, every modification done on the object “John” will be replicated in every of its shapes.  

Removing or Deleting an Instance 

 

 

At this moment, it is convenient to point out that with Del-key, Ctrl-X or Object  Delete from 

Drawing you are only erasing the chosen shape from the drawing area, but not removing it from 

SemTalk‟s object base. In case you want to remove an object from the drawing area AND from the 

object base, you must use Remove from the context menu or Object  Remove the menu bar.  

Please select the an Instance in your drawing area and right-click on the shape.  

In this way, you removed the from the object base and from the active page, as well as, from every 

other page of your SemTalk model. In SemTalk, there is no Undo command that to restore the 



  SemTalk Tutorial 

 Email: support@semtalk.com   9 

removed object and its properties.  If you delete an object, you may restore it in your diagram(s) using 

Insert or drag it from the Explorer. 

Other SemTalk model-based functions like Browse, Find and Expand are described later in this 

tutorial. 

Class Diagram 
So far, you have created instances of classes. The meaning of the Visio® shapes you previously used 

is defined in class diagrams. In our example, we used Visio® shapes related to users and we gave 

them individual names. In a class diagram, we could now extend the definition of our model by 

defining that a user uses a product. This declaration is valid for the instances we modeled before. 

Furthermore, in the class diagram you can define attributes that are inherited by subclasses of your 

class. For example, the subclass “Expert” will inherit attributes and relationships from the class 

“User”. Abstract classes, e.g. “Person”, have no Visio®-shape (yet) and therefore, you can use the 

general class symbol. 

        

Creating a Class Diagram 

Each SemTalk page has a type, i.e. an instance type or a class type. Thus, the first step is to define the 

page as a class diagram. To do this, insert a new page by: 

 Select from the menu bar Diagram  New  Class Diagram or 

 Alternatively, select from SemTalk‟s Explorer (tree structure) the node Diagrams/Generic and 

from its context menu (right click on the Generic node) the option Class Diagram. 

 

Please change now the diagram‟s name “My Classes”. Now you are ready to insert and create more 

class shapes and thus give your model more semantic consistency and expressiveness. 

Creating a New Class 

 

At this moment, you are ready to begin defining classes. If you drag & drop the shape “User” in the 

drawing area, you will define general properties of the class “User”. Remember that everything you 

define for a class is valid for its instances. 
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Adding a new class using no predefined Visio® Master Shape is very easy. Please drag the class 

symbol from the “Class” stencil window and drop it on the drawing area. You may just write a name 

on the shape or open its Edit dialog to create a new class. For example give the shape the name 

“Expert”. 

 

In the next sections, you will learn how to edit classes and instances. Therefore, the term object will 

represent both classes and instances. In most cases, the edit dialogs are the same for both of them, but 

exceptions are highlighted. 

 

Editing objects - General Tab 

To edit a class and its properties, 

 double-click on the object or  

 press the right button of your mouse and choose Edit from the context menu or 

 from the menu select Object  Edit  or 

 find the object in the explorer as a child of Diagrams  Generic  My Classes (context 

menu) 

 find the object in the explorer as a child of Objects (context menu) 

You should now see the following dialog box: 
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Name The name of the object. You may change this name to specify the class name. 

Namespace The namespace of the class name for the object. The identifier of an object is the 

combination of a namespace and the name. E.g., “Tr#Treasurer” is the object named 

“Treasurer” in the namespace “Tr”. There might be another object “Hu#Treasurer” 

which is also displayed as “Treasurer”. Use each name only once in a namespace. 

You can precisely define an object companywide or even worldwide by combining 

of the name of an object and an Error! Reference source not found., e.g. like this: 

"http://www.SemTalk.com/banking#Bank". Each name can be used in a namespace 

only once. 

Comment The description or definition of the class. 

Language To specify the language of a comment. Objects may have multiple names in different 

languages and multiple comments. 

Links e.g. hyperlinks can be added or deleted using the context menu (right-click) of the 

Links text field or the “+” or “-“button respectively. 

Read Only Marks the class as read only and protects it e.g. from renaming or deletion. 

 



  SemTalk Tutorial 

 Email: support@semtalk.com   12 

 

In the Hyperlink dialog, you can enter the following information: 

Address Use to type a Web site's URL, starting with the protocol (such as http://) or type 

the path of a local file (a file on your computer or network) that you want to link 

to. Alternatively, click  to locate the file or Web site. 

Subaddress If the text field Address is empty, it displays a page in your SemTalk model that 

you can link to. If you enter the path of a local MS Excel file or a Visio file in the 

Address text field, you can a named location (e.g. an Excel Worksheet or a Visio 

page) within the target associated with the specified file.   

ExtraInfo Use this argument to specify additional information that HTTP requires to resolve 

the hyperlink. The most common uses for this argument are to send a Web server 

the contents of a form, the coordinates of an image map, or a search parameter for 

an ASP file. (Example: Address: http://www.google.com/bin/search ExtraInfo: 

?q=keyword) 

Label Use to replace the hyperlink character string with text of your choice. 

Language If you are working with multi-languages models, choose a language that relates to 

the target specified through the hyperlink. E.g., you want to link a document 

explaining the tasks of the bank treasurer in different languages. If the object has 

been translated to English and Spanish you may attach different documents for 

each language. 

Frame A HTML Target frame where the document will be opened 

New Window The document will be opened in a new (Browser-) Window 
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Attributes 

The attributes of a class can be defined and edited on the Attributes tab. Some Visio-Shapes have 

already attributes. You can use them, but you can also edit them or just delete them.  
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Please create the attribute “Address” by pressing New. 

  

Double click or press the Edit button to open the attribute details dialog box. The button Delete is 

intended to delete an attribute. Value is a convenient way to enter a larger piece of text into an 

attribute value. 
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Type Specifies the type of this attribute e.g. Symbol, Boolean, Float or Number. Attributes 

do not require the selection of a type.  

Value The default value for this attribute. 

Is List Allows the use of multiple valued attributes. E.g. “red”and “green”. 

Options Specifies the options for values of that attribute E.g. “red”, “green”, or “blue”. Those 

options will be used as options for the values combo box. 

 

After closing the dialog, the value is shown in the right part of the attribute list. 

NOTE: The Error! Reference source not found. of attributes and values is explained in the course of 

the section 0. 

Language 

SemTalk offers you the possibility to create multi-language models. You can give every class, 

association class, instance, attribute or method different names in any language. SemTalk supports 

Unicode characters, which means that it supports Chinese, Arabic, Japanese und other character types. 

Open the edit dialog for the class “User” and go to the tab Language and press the New button. You 

should the following dialog. 
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Enter the term “Benutzer”, which means “User” in German. Select “German” from the Language 

combo box or enter a new Language. 

 You should now see the following dialog as result: 
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Associations 
The Associations tab of the class or instance editor shows the object‟s associations and they can be 

edited there. Nevertheless, the easiest way to create, edit or remove an association is to do it 

graphically.  In order to do this, we will add additional classes to this example.  

From the “Work Flow Diagram Shapes” drag & drop the Product shape in your drawing area. 

A class can have subclasses that represent concepts that are more specific than the superclass. The 

“subClassOf” association defines a taxonomic (subclass – superclass) hierarchy. Adding relationships 

is quite simple.   

Drag & drop the “subClassOf” shape somewhere in the drawing area or by clicking first over the 

Connector Tool   on the menu bar and then clicking over the “subClassof” shape in the CLASS 

Stencil. 
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If you pull the end-point of the arrow over an object‟s “connections point”, you will notice that you 

can glue the relationship to that object. With the “Connector Tool”, you just must click over the two 

shapes you want to relate. You can do it more than one time consecutively. A red coloring tells you if 

the connection was success. Select an end-point and glue your new relationship to the objects of your 

choice. Notice that in case of the “subClassOf” relationship the arrow points toward the superclass. 

NOTE: Use always a singular name as object name. It is not recommended to use the class “Users”, 

since the class “User” already describes one or more Users. 

In our model, “Expert” became a subclass of “User“. It inherited the attributes of “User”, but you can 

now add further attributes to “Expert” (e.g. Domain) or change the values of inherited attributes using 

the Edit button. In the same way, “User” is a subclass of “Person”.  
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Inherited attributes are characterized by a “*”. If you change the value of inherited attributes, 

SemTalk‟s object engine creates a local copy of the attribute. It will be deleted when you delete (reset) 

its value. 

Please take a look at the model explorer. Below “Objects” you will see the inheritance hierachy. 
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x 

Associations can be made graphically using the “Property“ connector. After adding the connector you 

will be prompted for an association name. Define a new association between User and Product. As the 

Property name, type “uses”. 

 

 

NOTE FOR VISIO 2007 AND VISIO 2010: 
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As Visio 2007 users may have already noticed, Visio offers a new tool to connect neighboring shapes. 

As the figure shows, you can choose one of the blue arrows from the origin shape (just move the 

mouse pointer over it) and Visio will mark red the next neighboring shape. Click on the blue arrow to 

confirm the selection and SemTalk opens the association dialog box immediately after. Visio 2010 hat 

“Quick Shapes” which to allow a very fast construction of a diagram without drag & drop. 

Association can be made without graphics using the Associations tab. 
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If you open the Edit dialog box for “Product” and select the Associations tab, you will notice, that the 

relationship is named “inv uses”. “inv” means that it is the inverse relation and no specific inverse 

name of “uses” has been defined yet. If you right-click on a link and choose Edit you can edit the 

properties of the association. To edit the relation class “uses” select “Edit Class” on then connector 

itself: 

 

find this class in SemTalk‟s Explorer under Associations. Edit this class and change “inv uses” to 

“used by”. 
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Notice the association‟s context menu has more options: 

 

Change Relation Use to change (create a new association or replace 

it with an existing one). The original class 

association is not erased or modified, just replaced 

between the two associated objects. 

Invert Relation Use to reverse the direction of an association. 

Edit Class Use to open directly the edit dialog of the 

association‟s class. 

Browse is explained later in this tutorial. 

 

NOTE: Remove deletes the association from the model. Deleting using Delete from Drawing or the 

Del-key only removes it from the drawing. Classes and other objects behave in a similar manner. 

You can change the class of instances by using the Class combo box of this dialog box in the Edit 

dialog. 
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Basic SemTalk functions 
In the following sections, you will learn about SemTalk basic functions while modeling. In some 

cases, the examples in this tutorial will need supplementary models to illustrate the functions. Some of 

these models can be found online and their URL will be appropriately listed. 

Saving a Model 

Please use Save or Save As. In addition to Visio®‟s VSD file, a XML file for the model is created. 

You may turn of saving of XML files via SemTalk->Options. Internally SemTalk saves an XML 

anyway. The external XML is used only used for referencing objects from other models. If the XML 

file get lost, it does not really matter since SemTalk creates a new XML file everytime you save. 

You can use Visio's AutoSave from the Visio options. 

If you use Sharepoint Integration you may directly save into Sharepoint document libraries.  

 

Comments 

In order to display a comment / definition of an object drag & drop the “Comment” shape in the 

drawing area and point with the “definition of” connector to one or more objects: 

 

By double-clicking on the comment shape, the Edit dialog of the object will open. 
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Changing the language for the comment will allow you to maintain comments in multiple languages.  

Insert Objects 

You can insert existing classes in new diagrams very easily with SemTalk. Please create a new class 

diagram. Having done that, please right-click on the drawing area and choose Insert (Model) to insert 

existing classes into the new diagram. Alternatively, you may use the menu Diagram  Insert. You 

will see the following dialog box: 



  SemTalk Tutorial 

 Email: support@semtalk.com   28 

 

Object Filter You can insert classes, relation types or diagram types into generic class 

diagrams. For other diagram types restrictions may apply. The second 

combobox of the object filter allows filtering by subclasses or instances 

(applies only for Diagram types with a root class) 

Existing As default the list contains only objects, which are not shown on the 

current page.  If you check Existing, you can insert those objects again. 

All / Not ReadOnly / 

ReadOnly 

Include classes, which are marked as ReadOnly or not. Typically these are 

the elements of a method‟s Error! Reference source not found..  

Invisible You can insert only those objects that exist in the model‟s object base, but 

are not present in any page. 

Insert all valid 

Relations 

All relations, which are in the object base, to other objects on the diagram 

are being visualized. 

All Selects all the objects in the list at once. 

Master (options) It specifies the shape to use. Default is until now used shape. UML uses a 

Error! Reference source not found.-style  class shape. Shape searches for 

a shape master with the same name as the class. 

NOTE: You can change the size of the Insert dialog box with your mouse. 
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Expand 

When objects are expanded, diagrams are extended using information that has already been modeled.  

For example, if a User is associated with Product, we can add related objects to the active diagram 

based on information modeled in other diagrams. 

Insert the class “User” in a new diagram and right-click Expand on the class. Alternatively, you may 

use the menu Object  Expand. 

 

Select “uses” and press OK to insert the class “Product” in the diagram. 

For the expand options see “Insert” 

Browse 

With the Browse command in the context menu (right-click on an object) you can navigate to other 

visualizations of that object. Alternatively, you may use the menu Object  Browse. 

The upper list box shows all diagrams that have a node for the object. The lower list box shows all 

diagrams that have a node with objects having a relationship to the object. 
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In order to show the object in different diagrams just selecte it. To navigate to related objects use a 

double-click on the object. By checking / deselecting the options Super, Sub, Relation and Instance 

you can filter the objects in the lower list box. Objects with compose is used for Business Process 

Modeling only. 

Find 

The command Find is located on the context menu of the drawing pane or in the SemTalk menu. With 

Find you can search objects displayed on your diagram and navigate to them. 
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Name The string to match. Blank “Name” matches every object. 

Begins with Searches only for objects where the name starts with the string in Name. 

Match case Use to carry out a case sensitive search. 

Match whole word Use to find the whole string only enter in Name. 

Find Use to begin searching. 

Find in Files Use to search a string in local SemTalk model xml files. 

Show Go to the object‟s location in the model. 

Edit Opens the selected object‟s edit dialog. 
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Object Properties Select the properties the objects to be searched. 

Object Types Select what kind of object is to be searched. 

Look for files in subfolders Use to search subfolders of the folder selected when using the 

command Find in Files. 

The tree view shows the matching objects and corresponding type. You may double-click an object or 

use Show to go to the object. 

Remove 
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The Remove command on the context menu (right-click on a node) will delete the object or 

relationship from all diagrams in the model. Alternatively, you may use from the tool bar the menu 

Object  Remove.  

NOTE: Objects that are not displayed in any diagram can only be deleted from the model using the 

explorer or Remove Multiple. Select the object in the explorer and use Delete from Model. 

Remove Multiple 

The command Object  Remove Multiple gives you the opportunity to remove more than one object 

at once. 

 

When you are working with modeling methods (e.g. process modeling methods), the combo box Class 

acts as a filter.  

Because with this dialog you can remove several objects at once and there is no Undo possibility, 

pressing Delete button will execute the removal of the objects and not the OK button. 
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Unify 

To combine two objects, select for the menu bar the options Object  Unify. One of the objects will 

inherit every relation, attribute and visual representation of the other object, and thus the later will be 

removed. 

 

Refine / Detach 
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The right-click command Refine attaches a diagram to an object. You can also use Object  Refine.  

If the object has a refinement, Refine will open the corresponding diagram immediately because of a 

kind of hyperlink navigation.  

You can navigate back from the refinement to the refined object using Diagram  GoUp or selecting 

GoUp from the context menu of a diagram (by right-clicking an the drawing area of a diagram). 

NOTE: Objects having a refinement are highlighted with underlined text. 

The External button assigns a diagram in another SemTalk model. 

NOTE: The diagrams are attached to the object, not to its visualization. This implies that the object is 

refined in all diagrams. 

The resulting refinement tree is reflected in SemTalk explorer: 
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The command Detach removes the link to the diagram, but not the refined diagram itself. 

 

External  Model 

There are different ways to insert external models in a SemTalk model.  Next, we explain two 

alternative ways to insert external objects in SemTalk models. 

Load Individual External Models 

 

In order use external objects in a SemTalk diagram, an external model must be loaded first. Loading 

an external model is very easy. From the menu, select File  Show External Model.  
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From the submenu list, choose File for a local file, URL for a model published in the internet or 

Repository if you are using SemTalk database variant.  In the first two cases, you are searching for the 

XML file of the model. You do not need the Visio file or HTML file for this operation.  

For the purpose of this tutorial, we created in advance an “Urban areas” model to be imported 

http://www.semtalk.com/pub/urban.xml. You can use File  Show External ModelURL to 

reference it. 

Once you have opened the XML file, SemTalk‟s Explorer should look like this: 

 

As you can see, the explorer contains new grey colored objects. These objects exist in the “to-be-

imported” model. Until now, they exist only virtually in the “urban” model. To make them part of 

your model you have to import them. There are four ways to do this: 

 Drag & drop the object(s) in your diagram. 

http://www.semtalk.com/pub/urban.xml
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 Mark the grey colored object from SemTalk Explorer and select from the menu bar Object  

Import 

 Right-click over the grey colored object in SemTalk Explorer and select from its context menu 

Object  Import 

 

Please insert the classes “Building” and “House” using the way you prefer. Please notice that the 

objects inserted can only use the Default or UML shapes. 

Load multiple External Models 

Frequently, users work with more than one source of external objects. Imagine the following scenario: 

You are working a unifying model of concepts from different departments in your company. The 

model files are found in your company‟s intranet and on the internet. You need to visualize the objects 

you are working with constantly. 

To accomplish this task, you might want to load several external models to your working model at 

once. To do this, select from the menu options Tools  SemTalk Options  Ext. Models (Tab). 

You should see now the following dialog: 
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File Use to add local files (in your hard disk or intranet) to the external models 

list. 

Folder Use to add a folder of files (in your hard disk or intranet) to the external 

models list. 

URL Use to add URL address (xml file of the model published in the Internet) to 

the external models list. 

Sharepoint Use to add files located in a SharePoint Services Workspace to the external 

models list. 

Sharepoint List Use to add a objects defined in a Sharepoint list to the external models list. 

Remove Use to remove any link or path in the external models list. 

Always show 

external objects 

Use external objects in SemTalk dialogs. (instead of pushing the “External” 

Button. Objekts are imported/referenced as soon as they are being used. 

Translate external 

objects 

Try to translate objects from external models. Better uncheck this option for 

large external models, if you know that they are single language 

Refresh objects on 

starts 

Update all references to external model on startup  
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Edit a diagram 

Please select a diagram and right-click the option Edit. You may also use SemTalk  Diagram  

Edit.  

 

Name The name of the diagram. 

Class The diagram class (or diagram type). Diagrams are also SemTalk objects.  New 

diagram classes may be processes or product models. Details of how to create a new 

diagram class can be found in a later chapter. 

Type Specifies the type of object being displayed in this diagram. There are class diagrams 

and instance diagrams. 

Visible Indicates if this page visible in SemTalk, Word Export or HTML Export. The page 

will continue to appear in SemTalk Explorer, in case you need to make it visible 

again. 
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SemTalk Interfaces 
Most of SemTalk interfaces depend on the modeling method and the template been used.  Almost of 

SemTalk interfaces, options are located under File  Export / Import on the menu bar. Next, 

SemTalk basic interfaces will be explained. For specific interfaces, please check the corresponding 

methods. At the end of this section, you will find a complete list of SemTalk interfaces. 

Import Picture 

To insert a picture in SemTalk and not creating an object out of it, you may just use the copy & paste 

Windows function or use SemTalk‟s File  Export/Import  Import Picture command. 

SemTalk Import 

In order to merge SemTalk models use FileExport/ImportImport. Use import to merge 

complete or partial models. Select an existing model and the following import window will appear:  

 

 

On the left hand side, there is a tree view similar to the SemTalk Explorer where you can select objects 

by diagram or by hierarchy. Additional objects may be imported. On the right side, you can preview 

the page(s) to be imported  

NOTE: preview is not available for the Visio embedded version.  

NOTE: Do not try to change anything in the preview. You cannot save it anyway. 

Please check those objects or diagrams you want to import and afterwards use FileImport. 

Select from the Import dialog menu bar Tools  Options to pop-up the import options available, 

which allows to specify some parameters for the import.  
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Create References / Locations Each object will get a reference to the imported file so that it 

can be updated using Object  Refresh afterwards. 

Copy Audit Information Audit Information such as Created, CreatedBy will be copied 

from the imported model. If this option is not checked, the 

current user and the current time will be used 

Change Diagram class Use this option to import method specific ontologies (class 

models) and change the original diagram class. 

Replace Namespace Replace the namespace of imported classes by a new 

namespace 

Paste onto pages which already 

have shapes 

In order to enable incremental import, SemTalk per default 

does not import pages which are already exiting and have 

shapes. This means that you can not import “Process-1” from 

a different document if you also have a page named “Process-

1”.  

Checking this option will enable copying on used pages 

 

SemTalk Import is an option if you want to import complete diagrams or a large set of objects. If you 

need single objects Show External Model with Drag & Drop (see section 0) is more convenient. 

Semantic Web 

Error! Reference source not found. is the idea of an Internet made of data. Models for the Semantic 

Web are called ontologies. The W3C recommends storing information in the Semantic Web using the 

following protocols: RDF (~Instances), RDFS (~some aspects of classes as you have seen in SemTalk 

so far), OWL (http://www.w3.org/TR/owl-features/, complete description logic). 

In SemTalk we use Semantic Web data structures to exchange data in a vendor independent way. Any 

SemTalk model can be exported completely to OWL. SemTalk can import und use OWL ontologies as 

class models for various purposes.   

If you want to use SemTalk as an OWL editor, you should use the OWL template OWL.vst which has 

all the additional constructs, which are needed to cover the complete set of OWL feature. If you need 

http://www.w3.org/TR/owl-features/
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to exploit these features, we recommend using SemTalk in conjunction with reasoners such as 

PELLET (see Chapter 10 on details for working with OWL). The following example was created 

using OWL.vst 

 

 

In order to import OWL, RDFS, RDF data select File Export/Import  Semantic Web.  
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For example, import the following file: http://www.semtalk.com/pub/veggies.owl  

Additional SemTalk datatypes are needed. The standard OWL datatypes are found in the SemTalk 

program directory. 

NOTE: Instead of importing complete ontologies, you can use Show External Model with Drag & 

Drop (see section 0) and open an OWL file or URL. 

 

Load redisplay the contents of the file in the list box 

Links selects objects related to the current selection in the list box 

http://www.semtalk.com/pub/veggies.owl
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Invert inverts the selection of the list box 

Base Class is a common superclass for all object to be imported 

Namespace is the default namespace for all object to be imported 

Validate RDF with 

SemTalk Engine 

only those associations with are defined at classes are allowed and 

imported 

Document Information is meta data of the document 

Create References Each object will get a reference to the imported file so that it can be 

updated using Object->Refresh afterwards 

SemTalk Associations 

and Attributes 

If  you do not check this option, the import of ObjectProperties will be 

OWL compliant (“has Domain”, “has Range”). If you do check this 

option ObjectProperties will be mapped to SemTalk‟s more UML style 

Attributes and Associations, which make more sense in various 

SemTalk modelling scenarios but srew up the sematics of some OWL 

ontologies. 

 

 

 



  SemTalk Tutorial 

 Email: support@semtalk.com   46 

Exporting to OWL or RDFS is quite simple. You can choose to export classes, instances, meta model 

(read only classes) etc.  

 

 

If you have selected some objects in your drawing, only those objects will be exported. 

Remove Local 

Namespace 

Ignores the namespaces. This makes sense if you plan to export 

ontologies from process models 

Export Meta Model Export classes marked as “Read Only” 

URN Base namespace for the ontology 

Base Class only subclasses of that class 
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Prefix Prefix for the base namespace 

Export Document 

Information 

Title, Date, Creator, Subject, Description 

SemTalk Associations 

and Attributes 

If  you do not check this option, the import of ObjectProperties will be 

OWL compliant (“has Domain”, “has Range”). If you do check this 

option ObjectProperties will be mapped to SemTalk‟s more UML style 

Attributes and Associations, which make more sense in various 

SemTalk modelling scenarios but srew up the sematics of some OWL 

ontologies. 

 

Microsoft Office Word Export 

Generating documentation of your models is quite easy with SemTalk and Microsoft Office Word. To 

generate a Word document from a SemTalk model, select from the menu options File  

Export/Import  MS Winword. You should see the following dialog now: 
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On the upper right corner of the dialog, you see a tree view with the existing diagrams in your model 

classified according to their diagram type. You can select with the buttons between the two boxes, 

which diagrams to export to a Word document. Use the Insert->Add Text File button to insert text 

files (.doc, .txt, etc.) or Insert->Add Reports to add reports into the Word export. The items‟ 

sequence on the list on the upper left corner determines the order of the diagrams and text in the Word 

export. 

Use the File menu option of the dialog, if you want to do the following: 

Load Diagram List Load a predefine diagram list to generate as Word document. 

Save Diagram List As Save the current diagram list as .txt file. You may load this file and 

generate a custom Word export. 

Open Document Template SemTalk loads the Word Normal.dot as default template, but you 

may select a custom template with this command. 

 

More layout options on the Word export dialog: 

Caption Format Use to define the heading format according to your MS Word. 

Table Format Use to define the layout format of your tables.  

Drawings Use to include or not diagrams in the Word export. 

New Page for Each Diagram Use to define to insert one or more than one diagram in a page. 

Include Background Use to include or not the diagrams‟ background (e.g. company‟s 

logo), if they have any. 

Include TOC Use to include or not a Table of Contents at the beginning of the 

Word document. 

Include Text Use to include or not tables in your Word document. 

Include Title Document Title 

Include Cover page Document Title on an extra page 

Generate PDF Automatically generate PDF using Word2007 save as PDF 

 

In the Instance and Class tabs select what object properties and information to include in the Word 

export. 
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Microsoft Office PowerPoint Export 

With SemTalk you can generate automatically PowerPoint presentations of your models. To generate 

a PowerPoint presentation from a SemTalk model, select from the menu options File  

Export/Import  MS PowerPoint. You should see the following dialog now: 

 

You have the following options: 

Type Use to filter the diagrams after their diagram type. 

Create Title Use to give or not each presentation‟s slide a title matching the SemTalk‟s 

page titles. This is not recommend if you have a background page which 

also shows the page title 

Include Background Use to include or not the diagrams‟ background (e.g. company‟s logo), if 

they have any. 

New Document If this option is not checked AND a PowerPoint presentation is open, the 

slides are added to the open presentation 

 

Microsoft Office MS Excel Import 

The MS Excel Import function can be very handy when creating big models with lots of classes and or 

instances. Instead of creating every single class and/or instance in SemTalk, you can import them from 

a MS Excel spreadsheet. The only condition is that the spreadsheet must reflect SemTalk‟s logical 

structure. Therefore, an appropriate spreadsheet is included and you may find it in the following 

location: C:\Program_files\Common Files\SemTalk3\bulk-import.xlt. You may create your own bulk-

import spreadsheets, but you must follow the original structure. 
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To import objects from a MS Excel spreadsheet into a model, select from the menu options File  

Export/Import  MS Excel. Then select an appropriate MS Excel spreadsheet (e.g. bulk-import.xls). 

Once your are ready to import the objects and information in the spreadsheet, select from Excel‟s 

menu options Tools  Macro  Macros. You should see the following dialog: 

 

Click on the button “Export” and SemTalk will export the objects and information to Excel. “Import” 

will import the current elements back to SemTalk. “Clear” will remove all content from the Excel. 

“Process” is a sample intended for process modelling notations. It will create a simple process 

hierarchy from the spreadsheets data.  

All macros are includes in the document as source code. The intension of bulk import is to provide 

you with an API sample how to read and write SemTalk content. If you copy/change the macros to 

match your personal ideas you will have a convienient way to export/import mass data from virtually 

any other application. 

 

More Export / Imports 

The following is a short summary of export import options. 

Import Picture Insert a picture such as bmp, jpg etc in the drawing. 

MS PowerPoint Export to MS PowerPoint 2003. For MS Office only the 2003 version is 

supported. For Office XP and Office 2000 use SemTalk 1.2.5 

MS Word Export to MS Word >=  2003 

MS Excel Import from MS Excel >= 2003. Provides an MS Excel sample macro 
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to create SemTalk objects via the SemTalk API. 

MS Project Export and Import to MS Project. Available for KSA (“ksa.vst”), EPC 

(“epc.vst”) and others. 

SAP Explorer Import Solution Maps and other diagrams from the SAP Solution 

Composer, which must be installed. Some content of the Enterprise 

Service Repository ESR und Buiness Blueprints created via SAP 

Solution Manager. 

SAP R/3 4.6c Reference 

Model 

Import processes of the SAP‟s R/3 Reference model. An reference 

model database is required which can be obtained from SAP‟s Value 

SAP (Asap) CD. Use the template “epc.vst” 

AML / EPML (ARIS) Import and export of EPC models from other EPC tools such as ARIS 

via ARIS XML using the tool indepented standard EPML http://wi.wu-

wien.ac.at/Wer_sind_wir/mendling/EPML/  Use the template “epc.vst” 

BPEL Export of the Web Services format BPEL e.g. for BizTalk. Use the 

template bpmn.vst 

WSDL Import Create object definitions from XML-Schema files / WSDL. To be used 

with BPMN  

 

http://wi.wu-wien.ac.at/Wer_sind_wir/mendling/EPML/
http://wi.wu-wien.ac.at/Wer_sind_wir/mendling/EPML/
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Additional SemTalk Functions 
Next you will review additional functions intended to assist you create comprehensive models. 

Working with Visio Stencils 

You may define classes and instances based on Visio masters from any stencil. To open a Visio® 

stencil e.g. File  Open Stencils. In the embedded Version, use File  Shapes to open a stencil. 

 

NOTE FOR VISIO 2007 

If you are using SemTalk not embedded 

in Visio 2007 and you plan to use 

regularly Visio shapes, you should define 

the path for the Visio stencils. To do this 

select from the menu bar ToolsVisio 

OptionsAdvanced (Tab)File 

Paths… (Button). You should now see 

the following dialog: 

In the text field “My Shapes:” navigate to 

the directory where Visio saves the 

stencils (e.g. “C:\Program Files\Microsoft 

Office\VISIO12\1033”) (1033 for English 

version). 

 

NOTE FOR VISIO 2003 

Unfortunately, in Visio 2003 you cannot define a file path for the shapes you regularly use. In this 

case, you must navigate every time to the directory where the stencils are located. 

TIP: You may copy those stencil files that you regularly use to the directory “C:\My Files\My 

Shapes\”. SemTalk will automatically open this directory.  

NOTE: Users of English Visio will notice that there are two files .VSS with the same name for every 

stencil. The letters _M and _U tell you, which of the stencils is in Metric or US units.  
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NOTE FOR VISIO 2010 

 

In Visio 2010 the handling of Stencils has changed. You will open a new stencil now from the Shapes 

anchor window. 

 
 

New Visio Master 

If you drop a shape on a class diagram, SemTalk creates for each master a class. You may have to 

rename the class afterwards to match your requirements. If you drop a shape into an instance diagram, 

SemTalk will create an instance for each shape that inherits from the class with the master‟s name. 

Until now, you have created class diagrams with existing Visio-Master-Shapes or with abstract 

objects. You have also built instances with Drag & Drop. 
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If you want to create new Visio-Master-Shapes, you have two possibilities. Either you copy an 

existing Visio-Master-Shape or you create a new one. Important is, that the names of the template 

symbol correspond with the class names in the existing models. Therefore, please copy the respective 

Master-Shape and insert it in the Document stencil and rename the symbol (“Master-Shape-

Properties” in the master‟s context menu). Now, you can use the symbols from the Document stencil 

or create your own stencil to build your models. 

For the purpose of this tutorial, we use the Visio-Master-Shape for “Person 2” as “Manager”. Please 

do as follows: 

1. Open the Document stencil in the tool bar menu Visio  View  Document stencil. 

2. Open the “Work flow diagram shapes stencil”. (File  Open Stencil file: 

WRKFLO_M.VSS) 

3. Drag & drop the master “Chief executive officer” from the “Work flow diagram shapes 

stencil” in the “Document stencil”. 

 

Rename the master “Chief executive officer” to “Manager” in the Document stencil by right-clicking 

on the symbol and select Rename Master from the context menu. 

NOTE: In SemTalk, you cannot create or edit graphically a Visio master. Stencils and masters can be 

edited only in Visio.  

Please drag a “Manager” and drop it in your instance diagram. Then, assign a new name to the new 

“Manager” instance. 
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Instances which use the new “Manager” Shape must stay to that class. They can not be changed to be 

instances of other classes such as “Product” 

 

If use you use the generic Instance symbol, it can be changed to any class. Please, drag the “Instance” 

master from the “INST” stencil and drop it in the drawing area. 
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When you create instances with the “Instance” master, you can choose any class you wish.  
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Customize 

Customize specifies how objects will be displayed and which tabs will appears in the edit dialog.  In 

addition to the object‟s name, it is possible to show any attribute or association value. 

Layout specification may be overwritten for subclasses or for single instances. Please select the Person 

class from the explorer and select the menu Object  Customize or from the object‟s context menu 

in SemTalk Explorer. In the dialog, select the Text tab.  

Text specifies how instances of the class (or its subclasses) will be displayed in instance diagrams. 

Class Text specifies how the class itself or its subclasses will be displayed in class diagram.  

The left list box shows all currently selected attributes and the right list box shows all possible 

attributes or associations. Use “<” and “>” to add and remove selections. 

In case you have complex shapes, you can choose, by “+” and “-“ in which sub shape the value will be 

displayed. You can address up to ten sub shapes. Multiple attributes can be displayed in the same sub 

shape. By selecting Group you specify that you select the whole shape itself (and not a sub shape). 

  

Edit Dialog is used to customize the appearance of the object‟s edit dialog. 



  SemTalk Tutorial 

 Email: support@semtalk.com   58 

 

Here you can select which tabs to show in the object editor. The check boxes on the left side enable or 

disable SemTalk‟s system-defined tabs. If you were using a specific modeling method (e.g. a specific 

process modeling method), you would see a list of check boxes with the name of the method-defined 

tabs for that method. 

With “Associations->New” you have the option to specify new tabs for a specific association. A new 

tab will be added which allows to associate other objects using a dialog. 

NOTE: In the screenshot, you can see the other SemTalk tabs - Methods, States and Language. In 

particular, the language tab is quite useful for specifying alternative names for the object.  The 

SemTalk Find-Dialog also searches for label in different language (“Synonyms”).  

Class Text and Class Edit Dialog are basically the same for displaying and editing classes.  

On the Behavior tab you can specify important options how SemTalk manage new instances or 

subclasses of the class. 

Instances exist on exactly 

one Diagram 

Instances will be deleted from the objectbase as soon as they are 

deleted from the diagram.  

Anonymous Instances Behavior often used for activities in processes. You must have a 

master named as the class. If you renamed an instance of the class, a 

new super class for the instance is created. The instance is not 

individually named. It name is super class name + “.” +ID 

Refinement of Class Used together with Anonymous Instances: refinement will be 

attached to the super class and to the instance. E.g. the activity “write 

Book” will be refined by the same subprocess in all processes where 

write book is used 
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Create Subclass on Drop Similar to Anonymous Instances but used on classes. Every time a 

class master or class from explorer is dropped onto as class diagram, 

new subclass is created instead of inserting the class in the diagram  

Hide in Explorer This class is not shown as a root class in the SemTalk Explorer 

 

The Graphics tab gives you some basic control how the shapes will be displayed without the need of 

changing the Visio master shape 

Color Shapes showing instances of the class will get the specified color 

overwriting the color of the master 

Line Pattern, Line Weight Line Pattern and Line Weight applied to the shapes AND ALL 

Subshapes 

Use Image A bitmap to be displayed in the first subshape 

 

Associations and Instances 

The property connector is used to define associations between instances.  If two instances are 

connected, a dialog box pops up and offers the possible associations for the object‟s class. Only for the 

purpose of our example, an “Expert” uses a “Premium Product”, but does not use the at a “Community 

Edition Product”. 

Person

Expert

User
Product

uses

City

Building
works in

located at

Premium Productuses
Community 

Edition Product
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On instances this means that the expert Mary may not use the community edition but John, as a 

standard user may use any product. 

Expert

Mary

User

John Doe

Premium Product

Wonderware

Community 

Edition Product

Do the simple stuff

uses

uses

uses

 

You may change the association class of each existing link by right-clicking the connector and 

choosing Change Relation. Associations, which are not specified in the class model, are not allowed 

between instances.  

In this way, SemTalk adds semantics to Visio shapes. Class models (so called onotoligies) specify 

how shapes can be used on instances. This paradigm allows to define a huge range of modeling 

scenarios. 

In the Associations tab of the instance edit dialog, you may select an association (property) without 

displaying it graphically.  

Associations are ordinary instances of their association class. You may also define associations on 

associations. 

Association Classes 

Since associations are instances of an association class, they are used to define attributes. In our 

example, we can add an attribute “arrival time” on the class “works in”, which can then be edited for 

each instance. 
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Please add the association class “works in” to your class diagram, using right click insert on the 

background of the diagram. Select Relation Type in the type combo box and then “works in” in the 

list box. 

The class will be displayed in the class diagram. You may add now attributes, subclasses and new 

associations. 

If you need a specific Visio connector for an association class, you can drop a Visio Connector to a 

stencil and rename it to the name of the relationship you want to use. Using the new master shape will 

automatically select the specified relation with the matching name. 
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Association Class Options 

Associations can not just simply connect instances with instances, but they can also be used to connect 

instances with classes and vice versa. 

Please create the association class “manages” by associating the classes “Manager” and “Person”.  

 

Select “manages” in the explorer as a direct child node of Associations.  Open the dialog box using 

right click Edit (context menu).  

NOTE: You may edit any object from the explorer using right-click edit as classes, instances, 

diagrams and diagram classes.  
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The tab Details presents other options to specify which types of object may be associated (class or 

instance) and some of their cardinalities. 

 

In case of an aggregation, the class own relations and its inherited relations will be shown. When 

working with an aggregation, the relations of a subclass will be added to those from of a superclass. 

Aggregation can be here understood as a “is part of” relationship. Composition a specific “is part of 

relation” but has not a real meaning in SemTalk. It is simply used to display a diamond on the line. No 

partial objects will be deleted if you delete the container. 

With Tree, you prevent cycles. A Transitive relation is e.g. “bigger”. When A is bigger than B and B 

is bigger than C, then A is bigger than C. In case of Symmetric relations, the inverse name is the same 

as the name. Multiple means that between two objects more than one relation of the same kind are 

allowed. Unique means that only one relationship of this relation class is allowed to exactly one other 

object. 

Diagram Types 

You may create new diagram types in SemTalk. To create a new diagram type select from the menu 

options Object  New  Diagram Type. 



  SemTalk Tutorial 

 Email: support@semtalk.com   64 

 

Please enter a name in the dialog to identify the diagram type. 

Do not worry if you do not see the new diagram type in SemTalk Browser. Select from the menu 

options Diagram  New and you should see the new diagram type listed as an option. Click on it and 

you will see the new diagram type and diagram in SemTalk Browser. 

 

You may edit a diagram type to constrain the objects you may use in it, to open specific stencils to 

work with, to define what operations are available from its context menu, etc. To do this, select the 

node in the SemTalk Explorer for the new diagram type (in this case “My Diagram Type”) and select 

from the menu options Object  Edit. Please create a new diagram of type “MyDiagramType” 

because you will not find the diagram type in in the Explorer until it is used. 

Next, select the Diagram tab. You should see the following dialog: 
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Type Select Instance or Class diagram.  

Prefix To set a namespace to new classes derived from the Root Class of 

this diagram type. 

Root Class To set a class that clusters objects in this diagram type. If the 

diagram type is a class diagram, the classes on the diagram are 

subclasses of the root class. If the diagram type is set to instance 

diagram, the objects on the diagram are instances of the root class or 

its subclasses. The goal of the diagram‟s root class is to manage 

what objects are allowed on the diagram. This gives a diagram a 

context and it is necessary when modeling with a specific modeling 

method.  

Insert Instances To set a class in a class diagram, from which instances are allowed 

in the diagram. In other words, instances of a class are permitted in a 

class diagram. For an example, see section 0 on modeling with 

OWL.  

Class for new Swimlanes To be used in process modeling. A swimlane usually represents a 

human resource that carries out tasks illustrated on it. So may 

change the standard class for the swimlanes. 

Auto Select Relation To set that if only a single association between two classes exists, 

this association will be selected every time a relation is drawn 
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between their instances.  

Inheritance SubClassOf Relations will be offered on links between to classes 

Metamodel Relations only Only Relations, which are defined on system classes (no namespace) 

will be valid in the diagram 

Stencil To set which stencils open automatically when the page is visible. 

UML Class Shape To set the UML class shape as standard shape when class are created 

or inserted in a class diagram. 

Edit, Insert, Find, Go Up, 

Refresh, Context  

To add this option in the diagram‟s context menu. 

 

HTML Generator 

In order to create an HTML version of your model select from the menu bar File Save as HTML.  

Remember to save your diagram before using the HTML generator. 

 

 

Title Specifies the name of the Website. In case of working with multilingual 

models, the next field is used to specify the language in which the Website 
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will be saved.  

Stat page Determines the file path of the start page to be generated. Do not generate to 

network drives. Always generate to a local directory such as C:\myhtml and 

transfer the html afterwards to the fileserver. 

Select the following options to add elements and functionalities to the HTML export from the General 

tab. 

Goto Page Facilitates a fast navigation across the diagrams. 

Pan Zoom Allows zooming of the diagrams. 

Search Enables the search in the website. 

Property Pages Shows the properties of a selected object in a diagram 

Properties (Diagram) Even if you do not use Property Pages for all objects, you may want a 

Property Page for each diagram for navigation purpose 

SemTalk Tree Reproduces the SemTalk Explorer in the Website 

VML / Silverlight Specifies how Visio will generate graphics 

Language Use to define the language of preference for the model attached objects. 
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Under the Multi-HTML tab, you can decide which models to connect to your HTML export. 

Include external 

Diagrams 

Select to generate links to from objects in the to-be HTML model to other 

external HTML diagrams. NOTE: to open the HTML files of the external 

models from a HTML model all the start pages (not the supporting files) 

must be located in the same directory. 

Ext. References in 

new Window  

If selected, external referenced HTML models or documents (e.g. Word 

documents, forms, etc.) open in a new internet browser instance. 

Add files Use to add and search files yourself to the list of files for the multi-html 

export. 

Search files Use to search and add automatically files, which have a reference to the 

current model, to the multi-html list. 

NOTE: The linking of HTML files works only when the index files (i.e. HTML start files) of the 

linking web pages (models) have the same name as their XML files, since the intern referencing uses 

the XML file names of the external models. Please notice that the name of the index file should not 

exceed 38 characters. 

Under Tree Details, you can choose which object types are to be displayed. Normally, you will want 

to display classes and diagrams, but you can also choose associations, attributes, synonyms or 

instances.  
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Diagrams, Classes, 

Associations, 

Attributes (Caption) 

Normally, you will want to display classes and diagrams, but you can also 

choose associations and attributes. You may also change the node name of 

these objects in the tree view. (E.g. Classes -> Concepts or Associations -> 

Relations). 

Show Refinements on 

Top-Level 

Specify if diagrams that are refinements of other elements become root 

nodes in the tree. If not checked, user have a more hierarchical navigation, if 

it is checked users get a complete list 

Generic Diagrams In many uses case generic (or “Untyped”) pages are used for displaying the 

meta model. These pages should often be excluded from the html 

representation 

Show Subclasses on 

Top-Level 

Use to display in the tree view a hierarchical structure (subclass of) for each 

class. 

Instance List Use to display in the tree view only a list of instances a no classes. 
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In the Property Details tab, you can choose which properties are to be shown in the property frame in 

the HTML export. 

 

 

Visible Properties Select the object properties that you will like to see for an object in the 

property frame in the HTML export. 

Visible Attributes Select specific properties and associations that you will like you see for an 

object in the property frame in the HTML export. Simulation and BPEL 

allow to select common sets of attributes, which are usually not wanted 

Show Comments in a 

Popup Window 

Specify if an extra menu entry for the comment should be generated. The 

menu will popup an extra window showing to comment 

MouseOver 

Comments 

Specify if the comment of an object will be shown if a user hoover over the 

shape 
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Use the Hyperlinks tab to edit the path of the referenced objects in the current model. 

  

Find 

Replace 

You may search and replace up to three sub paths. The button Search 

Hyperlinks will search for existing paths in your model and display them in 

the Find text field. You may replace absolute paths with relative paths 

(“../”). Please remember that the relative path does not begin with the “Start 

Page” directory, but with the subdirectory “xxx files”. The “../” in the 

HTML tag tells the browser to go up one directory level (i.e. to the “Start 

Page” directory in this case.  

Copy Attachments Use to indicate that files attached to objects in the model will be copied to 

the target directory of the HMTL export. 

New Window for 

Attachments 

Use to indicate that the attached files should be opened in a separate instance 

of your internet browser. 

Popup Window Attachments will open in a limited Popup Window instead of a new browser 

window 
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Use the Filter tab to select those pages to be included in the HTML export.  

 

Organization unit, 

Buffer 

(If modeling method applies) Select one of the options to file the adjacent 

combo box with the corresponding objects. Selecting one of the objects 

filters the list of diagrams below, marking only those diagrams where the 

object is present. 

Diagram Type Selecting one of the diagram types filters the list of diagrams below, marking 

only diagrams of that type. 
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The PDF tab allows to specify that for each page a printable copy in the desired format will be created, 

to simplify printing of individual pages. You may choose from Bitmap formats such as WMF, SVG, 

JPG or use PDF. You can also use Word (-Export) to generate the PDF. Please select a template for 

this use case. 

Other options can be found at the Tools tab. 
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Other Browsers (Not 

IE) 

Visio generates HTML for IE 6 or superior. HTML export for other 

browsers has limited functions and generates are large number of small html 

pages. 

External Start Pages For each object, SemTalk generates an individual start page, where external 

models can be referenced. 

Sub- Process 

Navigation 

Navigation between lower level diagrams in process models 

Process Path Breadth crump navigation for process models. You‟ll a shape with text 

REFINEMENTPATH on the background page 

Visio Document SemTalk generates additionally a Visio document with the selected 

properties for the Visio Viewer. SemTalk object attributes are transformed 

into Visio User attributes. 

Support Files Specify how the folder for support files will be named. “_files” is not 

allowed for Sharepoint 

Link to Sharepoint 

Viewer 

A menu entry with a link to a specific webpage will be added. The ID of the 

object will be passed as an argument. The intendet use is to link elements to 

Sharepoint forms 
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The resulting HMTL: 

 

 

 

Report Generator  

In addition to all the multiple possibilities to view your business process, SemTalk offers you a 

comfortable way of generating reports of every model. 

To create new reports open SemTalk Report Editor selecting File  Report  Report Editor.  

With SemTalk Report Editor you can create reports, save and reuse report formats. The tree structure 

shows the logical structure of the query and the attributes included. The right part shows the result of 

the query as XML or as a table. 

In the right combo box, select “User”. The option “All Instances” will list direct and indirect instances 

of User. You can see now the attributes and related objects in the tree view. 

Now select in the tree view User / System Attributes /Name, User / System Attributes / Class, User / 

System Attributes / OnDiagram and uses / Product /Name to see a list of the Banks and the name of 

the treasurer who works there and in which page they can be found. 
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The objects, attributes and associations in the model determine the structure of the reports. The queries 

can be nested as deep as you need. 

The XML output can be saved as an XML file, as html table, which can be opened in many tools 

including MS Excel, directly to Excel or to a Sharepoint list. 
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Use the menu option Tools  Options to specify additional options for report.  

Include other model allows to run a multi model report. Other models will virtually merge in before 

the report as the report is being executed. Please make sure, that you are using models with a 

compatible Error! Reference source not found.. 

Extras and Tools 
Under the menu option Tools, different functions have been grouped. With the Tool  Explorer 

options, you can hide or show SemTalk‟s Explorer by selecting Show Explorer. With Refresh, you 

will renew the explorer. 

Table Editor 

With the Table Editor you have at your disposal another way to edit information in your models. You 

can create and use Microsoft Excel tables to visualize and edit information about classes and instances 

in your models. 
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Type Use to filter according the some of SemTalk‟s most abstract objects: 

Attribute, Class, Method, Relation, State 

Namespace Use to filter according to namespaces. <None> for classes with no 

namespace. <All> for classes regardless their namespace. 

Class Select a class to see a list of its attributes (if any). <All> to list the attributes 

of every class in the model. 

Diagram Select a diagram as filter argument. <All> to take into account every 

diagram. <None> to list those object that do not appear in any diagram, but 

exist in the object base. 

Comment Check to include the corresponding „comment‟ in the table. 

Instances Select to generate a table with the instances of the class(es) you set as filter 

arguments.  

Classes Select to generate a table with the subclasses of the class(es) you set as filter 

arguments. 

Export Generates an Excel table according to the filter arguments. 

Import Imports the values you changed in the generated table. 
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Language Use to translate the objects name in different languages and import them in 

the model. 

 

Macros 

 

The Macros command allows you to run small SemTalk complementary applications written in a 

script language. 

The example shows three subroutines contained in the file count.vbs. You can open a new macro file 

by clicking Open. Edit will open a script editor (not part of SemTalk). Execute will run the selected 

subroutine. 

 

Replace 

 

 

The Replace command is used to globally replace strings (rename) in different object properties. You 

have the following options: 

Name Replace the name of an object with another character string globally. 
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Location Replace a location path of referenced objects with a character string 

globally.  

Document Path Replace a location path of attached files (e.g. documents) with a character 

string globally 

Namespace Replace the name of an object with another character string globally. 

Refinement Replace the location of a refinement with another character string globally. 

(E.g. after moving the file of an external refinement to another directory) 

Substring This checkbox must be checked if you do not want to match singles 

documents e.g. changing a directory path 

ReadOnly Include ReadOnly objects 
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SemTalk Options 

SemTalk configuration options are found under the menu command Options (Tools  Options) 

SemTalk Language Options 

In the tab Language, you can specify the language priority for your models. You may specify a 

neutral language (option “<none>”) to develop a standard version of your model. In our example, we 

have specified “English” as our model language. Language 1-3 are used to specify alternative 

languages. E.g., Language 1 is English and Language 2 is Medical (as technical language). If there is 

no definition in Language 3, Language 2 is used. If there is no definition in Language 2, Language 1 is 

used.  

 

The Object Method and Method Object options are to indicate the semantic order of the name in 

which classes and instances of activities are identify. For example, in English, an activity would be 

expressed as Method Object (read Book), but in German, it is expressed as Object Method (Buch 

lesen). 
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GUI Language System Windows Operating System language 

Current Your Windows‟s Language settings. (Check under Start 

 Window‟s Settings  Control Panel  Regional and 

Language Options) 

Visio Visio‟s language settings. (Check under Start  

Programs  Microsoft Office  Microsoft Office Tools 

 Microsoft Office 200X Language Settings) 

German, 

English, 

Spanish, 

Japanese 

SemTalk‟s predefined languages 

 

 

 

Let us add another language. In order to do that, please open now the edit dialog for the class “User”. 

Under the tab Language press New enter the German term for user “Anwender” and press OK. In the 

next Synonym dialog, please enter German as the language. 

 

You should be able to see now on the menu toolbar German as one of the optional languages for your 

model.  

If you are working with multilingual models, it is recommended to choose a neutral language, develop 

the first version of your model, and then change to a different language to specify the object synonyms 

in that other language. 
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If you specify “German” as Language 1, every object that has a synonym in German will have a shape 

label in German, as well as the name in the edit dialog.   

 

Shortcuts 

If you are using references to external models, namespaces (URNs) can get quite long. In the 

Shortcuts dialog, you can define shortcuts for namespaces, which are used in all SemTalk dialogs. 

Shortcuts are assigned for the current user and apply to all objects in the current model.  

Using New/Delete/Edit, you can add and assign shortcuts for namespaces used in the current model. 

OWL Import will automatically add all those namespaces and shortcuts found in the OWL file. 
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Explorer 

Using the Explorer options, you can customize the appearance of SemTalk‟s Explorer. The Explorer 

options are saved with the model (xml-file). 

 

Show Namespaces Displays the object  identifier in the tree view: Namespace#Name 

Show Diagrams Show the Diagrams subtree. 

Show Generic Diagrams Show diagrams without a specific user defined type. These often the 

metamodels 

Edit Diagram Types Create, edit and delete diagram types 

Show Objects Show the Objects subtree. 

Edit Objects Create, edit and delete object from the browser 

Subclass Hierarchy Show subclasses as inheritance hierarchy. If you do not select this 

option all classes are listed alphabetically. 

Edit Attributes  Edit and delete attributes. 

Edit Relations Edit and delete relation types (association types) 

Associations Show the Associations subtree. 
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Attributes Show the Attributes subtree. 

Methods Show the Methods subtree. 

States Show the States subtree. 

Datatypes Show the Datatypes subtree. 

 

General 

On the SemTalk options General Tab, you can define the following options: 

 

 

Sharepoint / Wizard Optional SemTalk Functions supporting collaborative work with 

SemTalk 

Hours per day Specify how many working hours a day has. Used with business 

process models and simulation. 

Template / Default Template Change the template which will be loaded when SemTalk starts. The 

“Default Template” is used in case the last template is not available 

in the current SemTalk derivate. 

Show Background Pages Background pages are usually hidden. Check this option if you need 

to change them. No SemTalk objects can reside on background 
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pages. 

Save SemTalk XML File Check this option to create an xml file of the current model without 

graphical information. Used to reference models. 

Load SemTalk XML File If unchecked SemTalk uses only the XML stored inside the Visio 

document 

Always use ‘Compose’ Intended for process modeling. Applies Object  Compose to 

every new activity. 

Open Stencils SemTalk opens the appropriate Visio stencil assigned to the current 

page type 

Show Language tabs always Language tab is always visible in Edit dialogs without customizing 

each individual class 

No BottomUp Methods Intended for process modeling. At Object  Compose new verbs 

can be entered that are not defined in a class model 

Check for Updates If checked, SemTalk tries to read the current version information 

from www.semtalk.com once every day. 

Upgrade SemTalk2 Mainly change the way how attachements are stored 

Show Paper Clip at 

Attachments 

Activities/Functions in the process modelling notations will a paper 

clip, if they have an attachment. Please note that this will work only 

on masters which are built on SemTalk‟s Activity master shapes 

Underline Refinements Underline the text of objects having a refinement 

Underline Attachments Underline objects having an attachment. Alternative to the paper 

clip. 

Show Transactions Functions with transaction will get a thicker border 

Show Language tab for 

Attributes 

Using this option you can specify language specifc values for 

attributes. Please note that this is only supported for the “Attributes” 

tab in the Edit Dialog. All other attributes entered e.g. in “Measures” 

tabs are not supported 

Use Visio’s Undo Function Visio‟s Undo is disabled by default, since many changes are being 

made which can not be undone in SemTalk. It may be used just to do 

repositioning of shapes. After using Undo a SemTalk consistency 

check will be made 

Change the System Class of 

Instances 

Instances of system classes can not be changed to other classes. 

Using this option you can do this even it is not recommended 

Do not hide Background 

Pages 

SemTalk automatically hides all background pages as soon as you 

change the active page. This is done in order to help you not to do 

modelling on background pages. 

http://www.semtalk.com/
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Use Root Classes for 

Compose 

Compose means to build activity names from nouns and verbs. This 

is done via the main business object modelling class (Object or 

Information in CSA). Using this option you will get more options in 

the sense that you can use other modelling elements such as physical 

resources to be combined with a verb. 

 

The SemTalk Options Path tab has these settings 

 

Template Dir File directory where the SemTalk templates are located and you 

have at least reading rights. As default, SemTalk saves the templates 

at Program Files\Common Fillies\SemTalk 

HTML Dir File directory where a HTML version of a model with the external 

objects in your model is located. If this text field is empty, SemTalk 

uses location path of the original XML file of the model to locate the 

HTML model.  

XML Files Store XML files in a specific directory. E.g. a Sharepoint folder 

SemTalk Menu XML file to specify which menu option will be shown in the 

SemTalk GUI 

Update Path Specify an alternative location for SemTalk version information. 

Values Types Here you can specify your own value types for attributes. See wss-
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stdt.xsd for an example. 

 

External Models 

You can predefine a list of external models, so that they are loaded and shown in SemTalk‟s Explorer 

automatically when you open a model. 

You will find this feature very useful if you use regularly information scattered in different models. 

For example, you can use organizational charts for your process models or process libraries on a 

regular basis. Next time you do it, you will not have to load them manually and SemTalk will keep the 

models semantically consistent. 

  

The external models can exist as XML files in your local file system, published on the Internet, in a 

SharePoint Workspace or as well in Sharepoint lists.  
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Any Sharepoint list can be assigned to any SemTalk Class in order to use list item as subclasses or 

instances. 

Using OWL.vst 
In order to use SemTalk as an OWL editor you may open the OWL template. File->New and select 

OWL.vst.  

This tutorial does not indent to teach you how to apply OWL to the modeling of your business 

problem. Please refer to the Spec (http://www.w3.org/TR/owl-features/) or to OWL tutorials out on 

the web (http://www.cs.man.ac.uk/~horrocks/ISWC2003/Tutorial/) to learn about the underlying ideas 

of OWL. 

 

http://www.w3.org/TR/owl-features/
http://www.cs.man.ac.uk/~horrocks/ISWC2003/Tutorial/
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The OWL template contains additional shapes to create OWL Diagrams. An OWL diagram is a class 

diagram, which also allows instances and some more restriction. The OWL stencil has some additional 

shapes compared to the standard SemTalk class stencil:  

 

The main difference compared to standard SemTalk is, that SemTalk assumes “Closed Word 

Semantics” while OWL assumes “Open World Semantics”. “Open World Semantics” assumes that 

every two object can denote the same concept unless someone states that they are different. This is 

crucial for the global vision of Semantic Web. 

For everything ignored by SemTalk, you might use a reasoner. For SemTalk you might use PELLET 

as a reasoner (OWL->Reasoner): 

 

 

equivalentClass Two classes actually denote the same concept. 

Ignored by the SemTalk Engine but exported to 
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OWL 

disjointWith No instance is allowed to be instance of both 

classes. Ignored by SemTalk Engine but exported 

to OWL 

Instance Just an instance 

instanceOf Graphically displays that the object is instance of 

a class. An instance can be instance of multiple 

classes. Supported by the SemTalk Engine.  

sameIndivudualAs, sameAs Two instances denote the same object. Ignored 

by the SemTalk Engine, which assumes closed 

world semantics 

differentFrom Two instances are denoting different objects. 

Default for SemTalk 

OWL Union An abstract class describing the union of a set of 

other classes. Use the unionOf relation to specify 

that set. Ignored by SemTalk Engine but exported 

to OWL 

unionOf Relation from a OWL Union class to other 

classes 

OWL Intersection An abstract class describing the intersection of a 

set of other classes. Use the intersectionOf 

relation to specify that set. Ignored by SemTalk 

Engine but exported to OWL 

intersectionOf Relation from a OWL Intersection class to other 

classes 

OWL ComplementOf An abstract class describing that instances of that 

class are not instance of another class. Use the 

complementOf relation to specify that other 

class. Ignored by SemTalk Engine but exported 

to OWL 

complementOf Relation from a OWL ComplementOf class to 

other classes 

OWL OneOf An abstract class describing that instances of that 

class are one of a set of other instances. Use the 

oneOf relation to specify that set. Ignored by 

SemTalk Engine but exported to OWL 

oneOf Relation from a OWL OneOf class to instances 

defining that class 
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OWL AllDifferent Operator specifying that all related instances are 

different. (Default in SemTalk) 

distinctMember Member of an AllDifferent Set 

AttributeType Graphically displays an Attribute Class 

(“DataProperty” in OWL) 

RelationType Graphically displays an Association Class 

(“ObjectProperty” in OWL) 

equivalentProperty Two AttributeTypes or RelationTypes have same 

meaning. Ignored by SemTalk Engine but 

exported to OWL 

subPropertyOf Subclassing of properties. Partially supported by 

SemTalk Engine but exported to OWL 

hasDomain Relation from a property to its domain. This can 

also be specified using the edit dialog Details tab. 

Supported by the SemTalk Engine 

hasRange Relation from a property to its range. This can 

also be specified using the edit dialog Details tab. 

Supported by the SemTalk Engine 

 

Help 
The Help command provides the user useful functionalities.  

Index Opens a short menu reference in HTML format. 

Tutorial Opens this tutorial from the www.semtalk.com 

Check and Repair Checks the consistency of a model and repairs any detected inconsistency. 

Using this function has the risk of deleting corrupt information and objects, 

which have inconsistency problems. 

Update refinement 

path 

Update the breadth crumb navigation 

Redraw and Rebuild 

Menus 

Rebuilds menus after the import of SemTalk 1 models 

Rename pages to 

Current Language 

To set the names of the pages of a multi-language model to the current 

modeling language. 

Registration Register your SemTalk license (SemTalk Key) here. 

Startup Screen To open SemTalk‟s initial screen and read more information on SemTalk 
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modeling methods. 

Install Visio COM-

Addin 

Install the SemTalk Addin for Visio 

Check for Updates To verify if new versions and/or hot fixes have been released. 

About SemTalk Version and license info 

 


